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Welcome

To the wonderful world of Slow Scan Television (SSTV). SSTV is a very fun and exciting mode to 
send and receive images using your computer, a keying circuit and your ham radio whether it's vhf or 
hf. Over the years sstv has grown in popularly and the software/hardware used to send and receive 
pictures with amateur radio has come a long ways as well. MMSSTV has many features not found in 
other sstv programs and the best part about MMSSTV is that it is free. This help file was written to 
help you understand MMSSTV and to start sending and receiving images over the air right away. 

When searching for something in particular and you cannot find it in the contents or index tabs. try 
using the search tab. you can also use Booleans (AND, OR, NEAR, NOT) in your search by either 
typing them in or clicking on the little arrow to the right of the window.

There is a MMSSTV discussion group on the internet. This is a place to ask questions to other users 
and even make recommendations or suggestions. Mr. Makoto Mori would appreciate it if you did not 
contact him directly, but used the group at yahoo.com.
Here is how to join.
1.) Go to http://groups.yahoo.com/group/MM-SSTV/
2.) Sign up for the MMSSTV group.
3.) You can do a search for keywords in previous posts to find out what has been discussed.
4.) You can post questions about MMSSTV to the group. Take a look through this help file before 
doing so to see if your question could be answered here. 
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MMSSTV is a Slow Scan Television program written by Makoto Mori, JE3HHT.
This Help file is Copyrighted© by Russ Ely, WL7LP, August 2004. 
I would like to Thank JA7UDE, Nobuyuki Oba for answering all my questions about certain options 
in MMSSTV. He was a big help. Thank you Oba 

The latest information and current version of MMSSTV can always be found on the MM Hamsoft 
website: http://mmhamsoft.amateur-radio.ca
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There are hot spots on the picture below. click on a section and it will take you to that section help area. Click on the home button up top to get 
back to this page.
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Main Menu

File

Edit

Open Log file Opens up the LogData file window. select the .MDT file you wish 
to use.

Save data now (F)
This lights up with add info in the log window and clicking on the 
QSO button.

Record sound to the file with 
a time stamp (A)

Records a sound file and stamps it with the current date and time. 
e.g. 08182030.mmv, also the word REC shows up in the spectrum 
window while recording is on.

Record sound to the file(W) A record sound file window pops up. type the name of the sound 
file you want it to be called. e.g. myfile.mmv

Play sound from the file Select the sound file you wish to use from the window.

Play position when playing a sound file and you click the hide button. click this to 
bring it back.

Rewind Rewind the file to the beginning for replaying

Close Record / Play Click this to stop recording a sound file. also this will close the play 
window if the hide button was clicked.

Exit MMSSTV(X) Shuts down the MMSSTV program.

Copy from RX window Copies the image in the RX window to the clipboard.

Copy from history 
window    Ctrl+C

Copies the image from the history window to the clipboard.

Auto copy

If the Auto copy in the Menu is checked, MMSSTV automatically 
makes an index to the picture in the QSL box in the Log pain of the 
main window every time when MMSSTV receives a new picture. The 
index looks like 0408251530, for example. If you receive two or more 
pictures in a QSO, MMSSTV assigns another index to the picture, and 
adds it in the QSL box, like 0408025130, 0408251531.

This is particularly useful if you use the MMSSTV built-in logger. Push 
List button and double click on a QSO. You have another window 
popped up. Push Pic. button at the bottom of the window. You will see 
the pictures you received during the selected QSO. The index gets a 
QSO associated with pictures.Auto copy to another folder and Assign 
another folder name must also be checked for this to work.

Edit TX image   Ctrl+E
Clicking this will bring up the MS paint program for editing the image 
in the TX window.

Paste to TX window This will paste the image contents from the clipboard to the TX 
window. 

Stretch paste to TX 
window  Crtl+V

works as a paste function with automatic picture resizing. The original 
image, which is normally stored in the clipboard, is automatically 
resized to fit to the TX window. In other words, it does not call the 
image clipper. At this time it does not work the way it was designed to 
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View

Option 

do. Developers are currently looking into it.

Paste via clipper This will bring up the clipper window, so you can adjust the image and 
then paste it to the TX window.

Handling of 320x240 Side menu deals with stretching options of 320x240 images.

Design
You can separate sections of MMSSTV into their own window for 
placing where you would like them on you screen. Standard brings all 
pieces back to default view.

Always show RX viewer This will bring up an external RX viewer. nice for when your editing an 
image for TX and you want to see the RX picture coming up.

Always Show Sync 
viewer This will bring up the external Sync window.

Always show thumbnails 
of history

This bring up a window showing the last 6 images in the history window 
and will move down the line as new ones come in from the RX window. 
Auto history in the RX window needs to be checked.

Always show thumbnails 
of files folder

brings up 6 thumbnail images in your stock folder. use arrows to scroll 
through images. double click to place one in the TX window. if all the 
image don't fit in the TX window, click on the stretch button. the clipper 
will then come up. Right clicking in this little thumbnail view brings up 
some options.

Always show control 
buttons Show the control buttons in it's own little window.

Level indicator Select between Receipt signal or Sync signal

Spectral display
Can turn the display off or select between FFT or FM demodulator 
settings.

Spectral display range
Select the range you wish to use. seem to widen or short the look in the 
display. image quality seems unaffected.

Spectral trail Can turn off the trail or make it raise and fall quick, short or long.

Spectral sensitivity This will adjust the sensitivity level of the spectral display.

Spectral Response Changes the response time in the spectral display. 

Waterfall Used to turn off and on the waterfall display.

Oscilloscope Brings up the MMSSTV Digital Scope window.

Soundcard 
output level

This brings up the soundcard Play control window.

Soundcard 
input level This brings up the soundcard Record control window.

Setup Repeater
To run MMSSTV in the repeater mode, add "-r" option:      MMSSTV.EXE -r   
Please see  Repeater Setup  for more info

Setup Logging
This brings up the logging setup window for setting up the logging program or for 
making changes.
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Profiles 

Program

Help

Setup 
MMSSTV

This bring up the MMSSTV setup window for setting up MMSSTV or for making 
changes.

Profiles 1-5 are default 
installed profiles

Select one you wish to use.

MMSSTV default MMSSTV has a special profile "MMSSTV Default," which cannot be 
modified by the user. This is the MMSSTV default parameter set.

Initialize all menus as 
MMSSTV default

"Initialize all menus" sets all the parameters back to the values on a clean 
install.

Assign profile
You can assign a profile using this option. it will be placed in the menu 
with a check mark next to it.

Delete profile Deletes profiles from the menu.

MS Paint Brings up the MS paint program for creating or editing images.

Programs 1-8

Shows a list of programs you have assigned to the menu. clicking one will 
start the program. MMSSTV will suspend and minimize if that program needs 
control of the com port and soundcard. click the MMSSTV icon on the task 
bar to restore MMSSTV when finished using the external program.

Assign Program
Clicking this will allow you to assign external programs to the menu. If the 
program your assigning needs control of the com port and sound card. put a 
check mark in the suspend box.

Delete Program Deletes programs you have created and takes them off the menu.

Restore Restores MMSSTV after being suspended

Suspend Puts MMSSTV in Suspend mode

Suspend+MiniMize This will suspend MMSSTV and MiniMize it.

MMSSTV Help Brings up this Help file.

MMSSTV.TXT Brings up the MMSSTV text file from the MMSSTV folder for viewing.

Version-up 
information This bring up the EUPDATE.TXT file in the MMSSTV folder for viewing.

Use Notepad Checking this will cause MMSSTV to use notepad for viewing text files.

MMSSTV web site This will start your browser and display the MMSSTV web site.

MMSSTV Reflector This will start your browser and display the MMSSTV yahoo group site.

NVCG Contest 
(Month) Brings up the NVCG.txt file for viewing.

JASTA Activity 
Contest (Month)

Brings up the JASTA.txt file for viewing.

Version Information 
(A)

Shows the current MMSSTV version you are using.
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Receive Window

Receiving pictures with MMSSTV is quite easy. after you have set your RX clock frequency
Right clicking inside the RX window will bring up a menu with a list of  options in it. For info on 
what each one does click here. 

(1) Tone frequency

SSTV's tone frequencies are defined as follows:
Synchronization pulse 1200 Hz
Low level of the image 1500 Hz
High level of the image 2300 Hz

There are four marker lines in the spectrum window of MMSSTV. From left to right:
Green line 1200Hz Synchronization pulse
Yellow line 1500Hz Low level of the image
Yellow dotted line 1900Hz Center level of the image
Yellow line 2300Hz High level of the image

To tune the frequency, make the signal energy be laid between the 1500Hz and 2300Hz marker lines. 
Alternatively, you can tune the receiver so that the synchronization pulses are on the 1200Hz marker 
line.
However, the synchronization pulse is very short, so it might take time for you to get used to 
adjusting the frequency in this way.

Since SSTV QSOs are made on the fixed common frequencies, you probably do not have difficulty 
in tuning the radio after you have done once.

(2) Automatic start

When the Auto button in the RX mode pane is depressed, MMSSTV automatically starts the receive 
operation in response to the start trigger signal.
The start trigger signal is called VIS signal, which consists of the 1200MHz marker signal and the 
SSTV mode code (1100Hz and 1300Hz FSK). MMSSTV detects the signal by using a resonant FSK 
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demodulator, and automatically starts the receive operation if it finds the mode supported.

To automatically start receiving, MMSSTV provides another method, which measures the interval 
time of the synchronization pulses. If you do not want to use this method, go to Option, Setup 
MMSSTV, select RX tab and choose 'VIS only' in the auto start option.

* Squelch - found under Options, Setup MMSSTV
Four levels (Lowest, Lower, Higher, and Highest) for the trigger threshold can be selected.
Lowest makes MMSSTV trigger with the weakest signal.
Highest makes MMSSTV trigger with the strongest signal. In other words, only the strong signal can 
kick off the receive operation.

(3) Manual start

In case MMSSTV does not automatically start receiving or you want to start receiving not from the 
beginning, push one of the mode buttons below the Auto button. In JA, HL, and USA, try Scottie 1. 
In EU, try Martin 1.

(4) Automatic stop, restart and resync

When the auto stop in the RX window of the Setup MMSSTV is checked, MMSSTV automatically 
stops receiving in case it has lost the synchronization signal (this does not work in AVT90).

When the auto start in the RX window of the Setup MMSSTV is checked, MMSSTV restarts the 
receiving from the beginning in case it detects the VIS signal even during the receive operation. It 
should be noted, however, that MMSSTV would not be able to detect the VIS signal because of the 
RxBPF effect.

When the auto resync box in the RX window of MMSSTV Setup is checked, MMSSTV 
automatically attempts to re-synchronize the RX image. This is useful if the MMSSTV has lost the 
synchronization during RX.
However, a couple of lines are displayed with the old synchronization timing and therefore they 
might appear as a thin bar.
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Receive menu
Right clicking inside the RX window will bring up this menu. Options are explained below.

ReSync - Clicking this will resync the picture if the sync sign was lost or interrupted for a second. 
Click the ReSync button at the bottom of the RX window does the same thing.

Copy - Copies the current RX image into the clipboard memory for pasting.

High accuracy slant adjustment - Automatic slant adjustment analyze the timing of the received 
signal to automatically adjust the slant. It, however, might not work well in the situations of QRM, 
multipath, or weak signals. Click on this after receiving a image in the RX window. This will straight 
the image out and produce a new set of RX clock frequency numbers. if you just want to straighten 
the picture out, then you need not do nothing more. however if you want to keep the new set of RX 
clock numbers, then clcik on the sync tab and click on the MEM button to record the new numbers 
into the setup.

Return to the settings sampling frequency - This will light up after you have used either the slant 
or smiley face buttons. After using the slant button to manually correct the slant in the image. click 
on the RX window and see if the new setting is to your liking. picture should be straight on both 
sides with no slant.  If it is not then click on this option to return to the RX clock numbers back 
before the change was made and try re-doing the slant correction. once you adjusted the image to 
where there is no slant. remember to click on the MEM button to record the new setting.

Accuracy of initial sync - When MMSSTV receives SSTV signals, it attempts to get its RX 
operation synchronized to the signals. Accuracy of initial sync specifies the number of scan lines 
used for locating the synchronization timing (point).

Normal: MMSSTV uses first four scan lines to locate the
synchronization timing
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Higher: MMSSTV uses first four scan lines to locate the
synchronization timing. It then uses 16 scan lines to locate the
synchronization timing again.

Highest: MMSSTV firstly uses four scan lines to locate the
synchronization timing. It then uses 32 scan lines to locate the
synchronization timing again.

MMSSTV uses the least squares method for locating the synchronization
timing. Therefore, the more lines it used, the more precise timing it
could generate.

Auto stop - This option allows the program to stop receiving an image if the signal become lost or 
too weak to copy.

Auto restart - When the auto start in the RX window of the Setup MMSSTV is checked or here in 
the menu, MMSSTV restarts the receiving from the beginning in case it detects the VIS signal even 
during the receive operation. It should be noted, however, that MMSSTV would not be able to detect 
the VIS signal because of the RxBPF effect.

Auto resync - When the auto resync box in the RX window of MMSSTV Setup is checked or here 
in the menu, MMSSTV automatically attempts to re-synchronize the RX image. This is useful if the 
MMSSTV has lost the synchronization during RX. However, a couple of lines are displayed with the 
old synchronization timing and therefore they might appear as a thin bar.

Auto slant adjustment - In Automatic slant adjustment, MMSSTV periodically measures the 
interval of the synchronization signals and automatically adjust the slant. When you leave this mode 
turned on, MMSSTV adjust the image in real time, but it gives slightly less accuracy than the High-
accuracy slant adjustment.

To start this method, check the Auto slant box in the RX tab of the Setup MMSSTV menu. You also 
can start it by right clicking on the RX window and selecting Auto slant adjustment in the pop-up 
menu.

Auto clear - Placing a check mark here will cause MMSSTV to clear the current image in the RX 
window at the start of the next incoming signal. leaving it unchecked will leave the current image on 
the RX window while receiving a new image. the new image will eventually cover up the old image.

Auto switch to RX window - Checking this option will cause MMSSTV to switch to the RX 
window automatically when a incoming signal is being received.

Copy to the history - If you have the Auto history option unchecked, this option becomes available 
in the menu. after receiving a image you can click this to copy it to the history window.

Background color - Clicking this will bring up a color palette. click on a color you like to change 
the RX window background color.

show size - With this checked, this will show the size of the image in the lower left bottom of the 
image.

Cancel - Closes the menu

Next
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MMSTV Setup

Demodulating method section - This section describes the digital signal processing used in 
MMSSTV.

MMSSTV has three types of demodulators.

(1) Demodulator configuration

MMSSTV's demodulator has the following configuration.

Sound --> BPF (FIR) --+> BPF1100 (IIR) --> VIS symbol '1' | +> BPF1300 (IIR) --> VIS symbol '0' 
| +> BPF1200 (IIR) --> Sync
| ---> Zero cross det. --> Picture data (1500 to 2300)
or
|
---> PLL(1500 to 2300) --> Picture data
or
|
---> Hilbert(1500 to 2300) --> Picture data

The zero cross detector's configuration is

---> Differentiator ---> Counter ---> Out LPF ---> Pic. data

The next figure shows the PLL configuration
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---> Phase det. ---> Loop LPF ----> Out LPF ----> Pic. data | | <---- VCO <-------------

The next figure shows the Hilbert transform configuration. I got this idea from JA6UHL Nishimura-
san (MNI TNX to JA6UHL).

--+-> Delay(N) -> Real | |==> ATAN -> Differentiator -> LPF -> Pic. data --> FIR(2N) --> Image

According to my experiences, they have the following pros and cons. Please give it a try by yourself 
to find your favorite method.

Decoder                                 Zero-cross                         PLL                           Hilbert transform
Color accuracy                          Fair                               Good                                   Good
Image resolution                        Fair                                Fair                                     Good
QSB                                       Good                               Fair                                     Good
CPU load                                Low                                Low                                    High
Sampling freq.                          HB*                               HB*                                ----------

*HB: The higher, the better.

In the zero-cross and PLL methods, you can set the cut-off frequency of the OutLPF higher.

In the Hilbert transform, the accuracy of the phase differentiation degrades as the sampling 
frequency increases. The default sampling frequency, 11025Hz, gives better results, though 
MMSSTV does the decimation to keep the transform accuracy.

(2) Zero cross detector parameters

[Out LPF]
This filter smoothes the frequency ingredients obtained by the counter. If you want a sharp image, 
increase the cut-off frequency. If you want a low-noise image, decrease the cut-off frequency.You 
can select an IIR or FIR filter for the Out LPF. However, it seems that they have no significant 
difference. The FIR filter is better for low sampling frequency because it consumes lower CPU 
power than the IIR filter.

(3) PLL parameters

The parameters of the PLL affect the picture quality. Since the behavior of this PLL is just the same 
as that of the hardware PLL, try adjusting the parameters as you have better results.

[VCO Gain]
VCO gain strongly affects the response of PLL. Higher VCO gain gives quicker response; lower 
VCO gain gives slower response. To high VCO gain would result in the oscillation of the decoded 
signal.

[Loop LPF]
In addition to VCO, the Loop LPF is an important parameter that dominates the loop dumping factor. 
Always use a one-order filter. If you increase the cut-off frequency, the oscillation amplitude of the 
decoded signal becomes bigger.

[Out LPF]
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The Out LPF filter does not affect the response of the PLL because it sits outside of the loop. It, 
however, should be noted that it strongly affects the picture quality. If you want a sharp picture, set 
the cut-off frequency higher. If you want a low-noise picture, set it lower. Adjust it according to your 
preference.

Differentiator - When the Differentiator box is checked, MMSSTV compensates the LPF effect by 
boosting the high-frequency ingredient of the received image. However, it makes the receive image 
be more likely affected by the noise. Try adjusting the effect with the slider for your preference. As 
the slider goes right, the differentiator takes sharper effect.

*The differentiator is not related to the differentiator of the zero-cross detector.

Level Convert - The level converter translates the frequency value derived by the decoder into the 
color amplitude values. MMSSTV provides two types of converters, which can be selected in the RX 
window of MMSSTV Setup.

- Linear converter (uncheck the polynomial box)
It assumes that the frequency and the color level are linearly related. It is simple, but the frequency 
characteristics of the decoder must be linear.

- Polynomial converter (check the polynomial box)
It uses a 17-th order polynomial formula for the level conversion. It works better if the frequency 
characteristics of the decoder are not linear. Since the converter uses a pre-calculated table to boost 
the processing speed, it should not require much more CPU load.

It is a good idea to use the polynomial converter for the 11025MHz zero-cross detector because it 
has a little linearity problem in 2200 to 2300Hz. As the sampling frequency goes higher, the decoder 
will have better linearity. However, even in 11025Hz, the conversion error is 2/256 - 3/256, and 
therefore the error might not be visible.

- Calibration - MMSSTV starts the automatic calibration by pressing the calibration button in the RX 
window of MMSSTV Setup. It takes about 20 seconds. After the calibration, MMSSTV shows the 
frequency characteristics figure. If the line of the figure goes straight down to the right, you can 
uncheck the polynomial converter (you can use the linear converter). 

Auto Start - VIS ONLY, Picture starts when MMSSTV hears the VIS signal only. this is sent at the 
start of a transmitting image. most people use VIS ONLY. VIS ONLY or Sync, Picture starts when 
MMSSTV hears the VIS signal or the pulse signals during any given transmitted image. Band 
conditions and qrm can sometimes trigger false starts and all you get in the receive window is a 
bunch of colored pixels.

Squelch level - Four levels (Lowest, Lower, Higher, and Highest) for the trigger threshold can be 
selected.
Lowest makes MMSSTV trigger with the weakest signal.
Highest makes MMSSTV trigger with the strongest signal. In other words, only the strong signal can 
kick off the receive operation.

RxBPF - Has to do with picture sharpness of an incoming signal and CPU power. If running a video 
card that only displays 256 colors and the program seems to be running slow because it's doing color 
pallet calculations. turn this off to save CPU power.

Auto stop - This option allows the program to stop receiving an image if the signal become lost or 
too weak to copy.
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Auto restart - When the auto start in the RX window of the Setup MMSSTV is checked, MMSSTV 
restarts the receiving from the beginning in case it detects the VIS signal even during the receive 
operation. It should be noted, however, that MMSSTV would not be able to detect the VIS signal 
because of the RxBPF effect.

Auto resync - When the auto resync box in the RX window of MMSSTV Setup is checked, 
MMSSTV automatically attempts to re-synchronize the RX image. This is useful if the MMSSTV 
has lost the synchronization during RX. However, a couple of lines are displayed with the old 
synchronization timing and therefore they might appear as a thin bar.

Auto slant adjustment - In Automatic slant adjustment, MMSSTV periodically measures the 
interval of the synchronization signals and automatically adjust the slant. When you leave this mode 
turned on, MMSSTV adjust the image in real time, but it gives slightly less accuracy than the High-
accuracy slant adjustment.

To start this method, check the Auto slant box. You also can start it by right clicking on the RX 
window and selecting Auto slant adjustment in the pop-up menu.

Auto clear - Placing a check mark here will cause MMSSTV to clear the current image in the RX 
window at the start of the next incoming signal. leaving it unchecked will leave the current image on 
the RX window while receiving a new image. the new image will eventually cover up the old image. 
most people have this checked.

Decode FSKID - This will Decode FSK ID's of the operators callsign and shows up in the call 
window.

Rx Buffer - If your running a 256-color video adaptor and system seems sluggish. To save the CPU 
power, Choose RX buffer FILE or NONE to turn it off. video adaptor with more than 256 colors, 
such as 16-24 bit true colors can use the ram setting. 

Next
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Transmit Window
To transmit an SSTV image, click TX button at the bottom left corner  of the main TX window. The 
image you have there is transmitted. If you want to abort the transmission, push the TX button again. 
Adjust the mic gain appropriately. Do not use the speech processor to adjust mic gain. This will 
make your audio too loud and cause some aliasing in the picture. ghost like lines around the objects.

There are several ways to prepare the TX image.

1. Drag and drop or double click an image from the S.Pix tab thumbnail gallery at the bottom of the 
TX window to the TX window.
2. Drag and drop an image from Windows Explorer or other file manager program to the TX 
window.
3. Drag and drop an image from another image viewing program such as ACDC that supports Drag 
and drop to the TX window.
4. Copy and paste an image from another graphics program, such as paint shop pro etc, to the TX 
window through the Windows clipboard.

When you right click on the TX window you will get a menu like this. click here for info about each 
option.

You can make the TX image superimposed with a template. The template operation is explained in a 
later section of this document.
Click the TX image with the right button of the mouse to get a pop-up menu that facilitates image 
manipulations, such as file load and save. Drag and drop from Internet Explorer is also supported.
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- TX button toggles the transmit on an off. 

- Tone button, clicking this will transmit a continuous tone until clicked again. you can 
change the pitch of the tone as well as the transmit time under the options / setup MMSSTV up top 
the menu bar. then TX tab and you'll find the settings for it near the bottom left. a -1 is a continuous 
tone.

- CW button, Clicking this will transmit your callsign or a macro over the air. Speed, tone and 
text can be change in Option/setup MMSSTV or Right click on the button to specify the text to send.

- Template button when turned on will place the current template onto your transmit picture. 
Learn more about templates here.

- Adjusts the picture and template for 240 line mode. This squeezes the image a little smaller to 
fit the 240 line mode.

- Shifts the picture and template upward for 240 line mode. The first 16 lines at the top of the 
image will be cut off.

- Adjusts the image so that the whole picture will fit under the header bar, when using headers.

- Shifts the image downward so that the top of the image is under the header bar. Note that some 
of the image at the bottom will be shifted down and not transmitted.

- Image Adjustment button. clicking this will bring up a image adjustment window, where you 
can control the brightness, hue, contrast etc. clicking on the edit button will bring the MS paint 
program to further edit your image.

- Paste button. Clicking this button will paste an image that is store in the clipboard memory 
onto the transmit window. when clicking this button you will get the image clipper window. when 
the image is a bit small or large.

- Zoom button. This will enlarge the current image in the transmit window for viewing. 
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Transmit Menu
Right clicking inside the TX window will bring up the menu. Options are explained below

High quality resizing with pasted thumbnail - This sharpens the image up a bit. giving it a more 
quality look to it.

Background color - Clicking this brings up a color palette. select the color you wish to use for the 
TX background window.

Add the items to the template - Grayed out

Copy - Copy image to the clipboard for later pasting.

Paste - Paste image from the clipboard.

Delete - Deletes the image from the window.

Load from File - Load a image into the TX window from disk.

Save to file - Save the image to disk.

Edit image - Opens up the MS paint program for editing the current image.

Test pattern - This will place a test pattern in the transmit window. some folks will use this to help 
others set their RX/TX clock frequencies.
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Image adjustment - This will bring up a window to edit the bright, hue, contrast etc of the image in 
the transmit window.

Show with template - Show the image with the current template. same as turning on the ABC 
button below the transmit window.

Auto margin - This works with the robot, AVT90 and B/W 12 modes. with it checked. it will shift 
the image and template (if templates are used)  upward automatically. the top 16 lines will be cut off. 
when using one of these modes you will noticed the "Shift picture and template for 240 line mode" 
button below the tx window is depressed. With it unchecked just the bottom 16 lines of the image is 
cut off and the image is not shifted upward.

Stretch TX image by different size - I've play around with this and at the moment it appears to do 
nothing.

Auto switch to RX window - This will automatically switch to the receive window when you have 
finished sending an image.

Show size - This puts a little window in the bottom left corner showing the size of the image.

Cancel - Close the menu.

Move folder only works on the thumbnail area, and will let you select another folder to use when 
pictures are saved to stock pictures area. If you want all your pictures saved in C:\pictures then select 
that directory when the dialog box asks you to select a folder.

Next
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MMSTV TX Setup

PTT - This is where you select what Com port you want to use for keying up the radio for transmit. 

*Note* EXTFSK port
EXTPTT port is provided for the PTT operation using a special USB device, which was originally 
made for FSK keying. To make use of this port, select  EXTPTT in the PTT port drop-down list of 
TX pane of Setup MMSSTV. EXTFSK.DLL is prerequisite for the operation. For more information, 
refer to the following web site. MMHAMSOFT web site. (MMSSTV Page)

JE3HHT Mori-san kindly offers a very good example code for EXTFSK. It is named 
COMFSK and available at MMHAMSOFT web site. With COMFSK plug-in, you can do 
PTT/FSK through legacy serial port, USB-serial adapter, or legacy parallel port (USB-
parallel adapter is not supported).

Exclusive lock - Check this if you would like MMSSTV to take full control and lock the Com port 
for it's use only.

RTS while Scan -

Radio Command button - Clicking this will bring up a radio command window. here you can have 
mmsstv control you radio.

TxBPF/TxLPF - MMSSTV generates the TX signal with the flow shown below.

Picture data ---> LPF ---> VCO ---> BPF ---> D/A ---> Sound data ON/OFF ON/OFF

LPF and BPF are used to limit the frequency of the digital output as insurance.
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If the CPU load is too high for TX, you can turn them off. However, I strongly recommend that you 
turn the BPF on when you use CWID.

[LPF]
This filter smoothes the signal translation from the image to the frequency domain.
As a result, the frequency bandwidth is substantially limited and the horizontal resolution of the TX 
image is slightly sacrificed.

[BPF]
This filter limits the bandwidth of the TX signal. It is useful to limit the spectrum spread for CWID.

 TxBPF -
TxLPF -
Tap -
Freq -
 f Button - Show a graph chart based on the numbers inputted in the Tap and Freq windows.

Tune button - This section allows you to change the settings of the tune button just below the Tx 
window.

Freq - Changes the pitch of the tone. Default is 1750 Hz.
Time length - changes the length of time the tone is transmitted over the air. Default is -1, 

which is continuous until you click on the tone button again to stop it. changing it to any other 
setting will only key up the radio for that specify amount of time selected in the time length window.

Auto TX (for SAT/UHF) -

Digital output level - This increase or decrease the audio output level being transmitted over the air. 
If folks say they can't hear your audio signal to well. but hears your voice signal just fine. then you 
need to slide the slider up for more audio output to the radio. slide it down if you are overdriving the 
audio.

Template Callsign - Place your Amateur radio callsign here.

Vari SSTV - VariSSTV, which is proposed by Mr. Samuel Hunt, is a method to protect the final 
device of the TX. He says that different colors have different 
brightness and therefore making the power lower in the way shown below gives better noise 
immunity.
Sync signal 100%
Red 29.8%
Green 58.8%
Blue 11%

I have no idea how effective it is. Please give it a try by yourself. Go Option, Setup MMSSTV, TX 
tab, and check the VariSSTV box under the digital output level slider. This is not operational in 
Robot36 or Robot72.

VOX tone - If you use the COM port to switch PTT or if you have a responsive VOX interface, you 
can eliminate the VOX tone, which is sent before the picture. Select "User defined" in the VOX tone 
pane, Push Edit button and delete all the definitions. MMSSTV no longer generates the tone for 
triggering VOX prior to sending a picture. 

Loop Back - This is used for helping to correct the RX / TX clock frequencies (slant) of the 
soundcard. 

Off - use this when you have your RX and TX clock frequencies set and are sending and 
receiving images straight with no slants. 
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Internal -
External (Full-duplex) -Most soundcards today have full duplex abilities. Whether this is 

the right way or the wrong way. This is how I use this option for setting up the RX and TX clock 
frequencies. I Connect an audio cable to the "Audio output" of the soundcard, connect the other end 
to "Line In" on the soundcard. Place a picture in the TX window for transmit. Turn the volume way 
down using the volume control on the task bar. transmit the image in Martin 1. after the image has 
been transmitted, you'll see the image in the RX window. click on the Sync tab and click on the 
smiley face and then click the MEM button. that records your new RX clock frequency. now 
transmit that same image in martin 1. after it has finished, click on the smiley face again and this 
time click on the TX button next to the MEM button. this records your new TX clock frequency. 
with both of them now set. transmit the same image and see if image comes in straight. This gets me 
really really close for sending images on the air. once you're finished, remember to set Loop Back, 
back to off and volume turned back up.

Some soundcards seem to use different sampling frequencies for the full-duplex and no-full-duplex 
operations.
In such a case, the offset calibration using the external loop back does not help. You should always 
have the loop back External or consult the QSO report.

Fixed Mode - A check mark in here will lock the current sstv mode. e.g.; sending and receiving on 
Scottie 1. mode would be locked on Scottie 1. Note that the RX receive would not receive an image 
from any other mode when checked. To receive a picture from another mode, click on the 
appropriate button. Once you do that then that mode would become the current fixed mode. Most 
people leaves this unchecked.

Encode FSKID - This will send a FSK signal with your call sign at the end of the image. which can 
be seen in the call window on the receiving station..

CWID - This option when enabled. sends a Morse code signal at the end of your transmitted image. 
This could be your callsign or whatever text you place in the macro window below. 

Off - Turns off the CWID feature. 
CW - Turns on the CWID feature. 

     MMV -Turns on the CWID feature, but plays an audio file instead of sending a morse code 
signal. when enabled a ref button will show up,  click it and a Choose MMSSTV sound file window 
will pop-up. select a MMV file you wish to use. 

Fast/Slow slider - Controls the speed at which the CW is sent.
Macro Button- There is a set of predefined macro's when you click this button. choose the 

one you want and that will be used to send when the CW is turned on.

Next
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RX/TX modes

Mode selection

Select the SSTV mode.

* If you uncheck "SSTV mode fixed" in the TX page of MMSSTV Setup option, MMSSTV 
automatically uses the SSTV mode that was used by the most recently received RX image.

Transmission

Push the TX button at the left bottom of the TX window to start transmission. The horizontal marker 
line moves from top to bottom as the image is transmitted. MMSSTV automatically returns to RX 
after it completes the transmission. If you want to abort the transmission, push the TX button again.

MMSSTV has a 12-second sound buffer, which should be big enough in the normal environment. If 
your PC is not powerful, you had better not do other operations during the transmission.

If MMSSTV has lost the timing during TX, it shows a caution message after the TX completion. In 
this particular case, you might be able to solve this problem by increasing the number of FIFO in the 
Misc page of the Setup window.

Right clicking on either the RX or TX button brings up a menu with a long list of modes. to change 
one of the transmit or receive buttons to a different mode. simply right click on the button you want 
to change and select the mode you would like from the list.

.
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Templates
Using a template, you can make a simple picture, which is superimposed onto the TX image. you can use commands for placing macros that puts 
his/her callsign on the TX image.

Make different types of template styles using the tools MMSSTV provides listed below.

- Arrow button turns on-off the selection pointer.

- Line button allows you to draw a  line on the image. use the L button to change it's style, color and width.

- Square button places a  rectangle square on the image. left click an hold button, drag mouse to make the size rectangle you want.

- Shaded square button places a rectangle square with color inside it. After placing square, use color palette to change colors. 

- T button allows you to place text on the image. using the color palette button allows you to change colors, styles and font's.

- Picture button Insert a picture or history image with options of different styles of frames and borders.

- Color bar button. draws a  color bar from left to right. can be resized. use color palette to change color (s). nice way to make colored headers

- Draw text from a defined list. click on the image and a window pops up. Click edit to add text to the list. select one from the list and it will be 
placed on the image

- Scissors button cuts the item from the image and is stored in the clipboard memory.

- Paste button Paste an item stored in the clipboard memory.

- Color palette button Changes the color of the text or line. just whatever you happen to have highlighted at the time.

- L button allows you to change the line style, color and width.

- f button allows you to change the font, font style, size and color.

To use a macro text, for example, push T button and then click the point in the window where the text is placed. The text input dialog box is 
displayed. Push Macro button and select %c to place his/her callsign there.

To move the item, click on the arrow button and use drag and drop method. 

Once you have created your template you can save it in your template thumb nails by left clicking the image in the template window and dragging it 
down to one of the empty  template thumb nail squares. to use any of the templates on your TX image. turn on the ABC button below the TX 
window. then click on your template thumb nail tab and double click the one you want to use. Tabs 2,3 and 4 are more thumb nails to place more 
templates. using the arrows buttons to the right will also give you more. as of right now. tabs 2,3 and 4 seems to be only for storing more templates. 

It takes substantial time to make the text change in effect in the template.
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For this reason, the window redraw is slowed down during superimposing of the template in the stocked image area. If you do not like it, try 
checking off Show superimposed templates or checking on Draft. In addition, the JPEG format will require a little bit longer time to re-read the file.

MSG button in the "Text & Color" window
=============================================
In the template window, you can add text by pushing "T" button just under 
the template window. Double clicking the added text gets the Text & Color 
window popped up. You can find MSG button at the bottom center of the 
window. When you push the button, a big square pane appears in the window. 
Input pre-defined text lines in the window. The text can include macro 
keywords. Double clicked line is copied to the text box.
For example, input the text lines in the white pane as follows.
Hello
Good morning
Good afternoon
Good evening
73
If you double click on 73, the content of the text box becomes 73.

OLE support

MMSSTV now supports OLE (Object Linking and Embedding). If the object is embedded (or linked) in the template, you can make use of the 
various 
functions offered in the object.

* Object means the whole or some part of the document in another application.

* What kind of object can you utilize in MMSSTV? It is dependent on the OLE application you have. If you have installed a word processor, for 
example, 
you can use the word processor document as well as all the functions, such as character effect and picture drawing, provided in the word processor.

1. Object embedding

To embed an object in the template, use one of the following five methods.

- Right click on the template window of MMSSTV, select Object -> Insert, and make a new object to embed. You can embed the existing file or 
place a link  to it in the template, too.

- Make an object in the other application and copy it to the clip board. Right click on the template window of MMSSTV, and select Object -> Paste.

- Drag and drop the target object file from Explorer or My computer to the MMSSTV template. It should be noted, however, that BMP, JPG, WMF, 
MTM, MTI, and DLL files are not embedded as an OLE object.

- Open the folder thumbnail window (View -> Always show thumbnails of files folder), and right click on the target picture in the window. Select 
"Embed  to Template as OLE." In this case, the embedded picture always becomes a bitmap OLE.

- Open the thumbnail folder as the OLE object type and double click the target thumbnail. You can use drag&drop, too.

2. Object editing

To edit the embedded object, just double click it. Another way to do this is keep the object selected and push the Set color button. If you cannot  start 
the server application, right click on the target object and select Object -> Edit.

The server application of the embedded object works as the editor. Please refer to the help file of the server application. For example, Windows  
Paint is invoked for the target application when a BMP file is double clicked.

3. Object displaying and resizing

MMSSTV displays the object in the overlay mode. If you do not want to get the background transparent, right click on the object, select Object, and  
uncheck Overlay. When "Object" -> "Stretch as bitmap" is checked, MMSSTV uses a bitmap resizing code instead of a metafile resizing code. 
Generally speaking, the  metafile resizing code gives better results for the characters with special effect. The bitmap resizing code, on the other 
hand, gives better result for image objects like photographs.

4. Custom item

If you are not satisfied with the MMSSTV graphic tools or the OLE functions, you can embed a custom item that you have created by yourself.

To embed a custom item, go with "Object" -> "Insert custom item," and select the target item. Another way to do this is to open the folder thumbnail 
as  Custom item type and double click the target thumbnail (or drag & drop it to the template).
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Template Menu

Convert to image item - When inserting a Object, clicking this will convert the object to an image 
item. right click again and you can convert the image item to a bitmap.

Image adjustment - Brings up the adjust image window to edit the brightness, contrast sharpness 
etc of the image. clicking edit will bring up the MS paint window for further editing.

Keep aspect ratio - When adjusting the image size smaller or larger. the image tends to get a warped 
or stretched look to it. clicking this will adjust the image to a more original look.

Resize to the original size - When resizing the image with your mouse. you can use this to quickly 
get back to the original size of the image.

Paste image - This will paste the contents of the clipboard onto the template window in either a 
bitmap or overlay form.

Undo - Clicking this will undo your last action.

Cut - This will cut the selected item from your work area and be placed in the clipboard memory for 
later pasting if needed.

Paste - This will paste the current item/image onto your template.

Delete - This will delete the selected item you have right click on from the template window.
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Object - This option goes beyond my scope of explaining. Insert brings up a insert object window 
and the only thing I can see useful in it are things dealing with images. Insert custom item brings up 
a window with the only file option are DLL files. don't know how a DLL file would be useful in a 
image. Just get an error message when I try loading a DLL file. Paste image will paste the current 
clipboard contents onto the template window.

Add text to the list - When adding text using the "T" button. you can click this option to add it to the 
draw text list.

Go to Back - Send the item or image to the back.

Go to Front - Bring the item or image to the front.

Background (transparent) color - This will bring up a color palette window. select a color for the 
background you wish to use.

Find unique color as background - Using this will automatically place a unique color on the 
background. changes each time you try it. if you got show TX picture turned on, then you won't be 
able to see it. same holds true for Background color option above.

All delete - This will delete everything you have made or loaded in the template window.

Samples - Clicking this will give you 5 samples you can work with and edit. generally these are the 
first 5 in the template tab.

Load from file - Selecting All will load a template into the window for editing. you can even load a 
template onto another template your currently working on. Selecting item, you can load in items that 
you saved from previous template projects.

Save to file - Right clicking in the window and selecting all will save your work as a template file 
with the mtm extension. right clicking on a single item will save that item to a mti extension and can 
be loaded into other template projects. 

Options - Moving the mouse over this option will bring up a side menu. Turning them on and off by 
clicking on the option.

Show transparent point - --|
Transparent point -            |------- Please see what's new section for a brief explanation. 
Auto transparent point - -- |

Disable font smoothing - When the Windows option "Smooth edges of screen fonts" is engaged, the 
background color of the template sometimes leaks at the edges of characters on the MMSSTV 
template window.

Draw dummy text of macro -

Show TX picture - This will show the current TX window picture in the template window. 

Use fast code - Speed of character mapping in the template window. Some PCs running in the 16-bit 
color mode does not work well with this code. In that case, unselect the fast code option.

Show size - Shows the size of the image in lower left corner of the window.

Size - A side menu shows up when mouse is over it. here you can pick several sizes to use. selecting 
size will effect all items in the template window.
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Cancel - Closes the menu.
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Receive history Window

MMSSTV can store up to 32 received images in default. To increase or decrease this number, click 
Option, select Setup, click Misc tab, and change the value in the History max box. If the number of 
stored images would exceed the specified value, the oldest image is erased in an FIFO manner.

It should be noted that one image requires about 200KB disk space, and thus 256 images require 
about 50MB. Pay attention to the disk space on your PC.

To reduce the disk space, you could use the JPEG format. Click the picture with the right button of 
your mouse and select Use JPEG format in the pop-up menu.

The RX history is only used for a temporary buffer. The old pictures will automatically be deleted. If 
you want to keep them, right click and check the auto copy to another folder.

With this automatic copy function turned on, MMSSTV records the index into the QSL field of the 
log so that it can retrieve the picture later.

To manually copy the history picture to another folder, drag and drop the picture in the history 
window to the QSL box in the log window. To use this function, you must define the name of the 
target folder in advance.

MMSSTV automatically records the index in the QSL field of the log, either if the auto copy is 
turned on or if the history image is dropped in the QSL box. Using the MMSSTV log facility, you 
anytime can refer to the image by pressing the Image button.

- These buttons allow you to view previous images that were received and stored. 
Clicking the left arrow scrolls through previous images, while clicking the right arrow works you 
way back to the most current. clicking on the greater signs button will bring you back to the last 
received image.
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- Copy button. Clicking this will place the current image you are viewing into the clipboard 
memory for pasting else where.

- Image Adjustment button. clicking this will bring up a image adjustment window, where you 
can control the brightness, hue, contrast etc. clicking on the edit button will bring the MS paint 
program to further edit your image.

- Zoom button. This will enlarge the current image in the window for viewing. 

Right clicking inside the history window will give you a menu with other options. Click here to learn 
about each option. 
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History Menu

Image Adjustment - Clicking this will bring up a image adjustment window, where you can control 
the brightness, hue, contrast etc. clicking on the edit button will bring the MS paint program to 
further edit your image.

Create a catalog image - This will put a number of images stored in the history folder onto the TX 
window for transmit. click on this will give you the option of placing 3 or 4. MMSSTV will place 
the last 3 or 4 in the TX window. you can use the arrow buttons to toggle to an image you want up 
and the last few behind it will also be place with it in the TX window. even when selecting only 3, 4 
will be on the TX window. whatever image you had current in the TX window will be the 4th.

Save to file - Save the current image in the history window to disk.

Save to file with time stamp - Save the current image in the history window to disk with the current 
date and time stamped in the lower left bottom of the image.

Copy -  Clicking this will place the current image you are viewing into the clipboard memory for 
pasting else where.

Delete - Delete the current image in the history window.

All Delete - Delete all the history images stored in the history folder or whatever folder you have 
them stored in.

Edit image - Clicking this will bring up the MS paint program for editing the current image in the 
history window.
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Move folder - This allows you to move the history images from one folder to the next. Default 
folder is /mmsstv/history. But you can make it where ever you like.

Use JPEG format - All history images are stored in BMP format. if you would like to save some 
space on your hard drive. you can use the Jpeg format so that the stored history files are not so big.

Use windows bitmap format - If you use the JPEG format describe above. you can switch them 
back BMP format by using this option.

Auto copy to another folder - Placing a check mark by this option will place all history images 
received into the assign another folder option described below.

Assign another folder name - Selecting this will bring up a small window asking you for a folder 
name. type in the folder name you want the history images to be copied to. * Note - You must create 
the folder on the harddrive first before using this option.

Write time stamp in the copied picture - If checked, All history images that are copied to the 
"assign another folder" will have the current date and time stamped on them in the lower left bottom 
of the image.

Copy as JPEG format - If Checked, All history images being copied to the new folder will be 
stored in the JPEG format. other wise they are stored as BMP.

Show size - If checked. the size of the image will be show in the lower left bottom of the image.

Cancel - Closes the menu window.

Next
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Adding Pictures

Adding pictures to your thumb nails as show below is quite easy. 

Right click in one of the thumb nail squares. A pop-up menu shows up, click on "load from file". A window pops up  select a image in the window and  
small little picture viewer will come up to show you what the picture looks like before adding it to the thumb nail. makes it really handy for searching for 
that one special image. once you have found the image you want to add. click on the open button. Once you click on the open button a new window 
appears on your screen called picture clipper. from there you can edit just how you want it to set in the thumb nail and also edit the image itself. if you 
like it just the way it's shown in the window. then just click the "OK" button to add it to your thumb nail. repeat the process for the remaining empty 
thumb nails. once those are filled up, click on the right arrow in the upper right corner of the thumb nails to add more pictures to another set of empty 
thumb nails. clicking the arrow will allow you to scroll through all the images you have added to your thumb nails.

Deleting pictures from your thumb nails is quick and easy. just right click on the image you want to delete and click on delete from the pop-up menu. 
you can also just replace an image in that square instead of deleting by selecting load from file.

Show with template box - Placing a check mark inside the box will put up all your templates onto your thumbnails to give you some what of an idea 
what they will look like on your images. template 1 will be on image 1, template 2 with be on image 2 etc etc. the draft option lights up at that time also.  
placing a check mark in the draft box will make your templates look like more of a 256 color design. with show with templates checked. if you double 
click on one of your thumbnails that image and the template will appear in your TX window. if draft is also checked and you double click an image the 
template with be shown in it's normal view.

On some slower computers with these 2 items checked. the window redraw is slowed down during superimposing of the template in the stocked image 
area. If you do not like this, try checking off "Show with templates" or checking on "Draft". In addition, the JPEG format will require a little bit longer 
time to re-read the file.
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Sync Menu
Right clicking on the Sync window brings up this menu.

ReSync - Clicking this will resync the picture if the sync sign was lost or interrupted for a second.

High accuracy slant adjustment - Automatic slant adjustment analyze the timing of the received 
signal to automatically adjust the slant. It, however, might not work well in the situations of QRM, 
multipath, or weak signals. Click on this after receiving a image in the RX window. This will straight 
the image out and produce a new set of RX clock frequency numbers. if you just want to straighten 
the picture out, then you need not do nothing more. however if you want to keep the new set of RX 
clock numbers, then clcik on the sync tab and click on the MEM button to record the new numbers 
into the setup.

Return to the settings sampling frequency - This will light up after you have used either the slant 
or smiley face buttons. After using the slant button to manually correct the slant in the image. click 
on the RX window and see if the new setting is to your liking. picture should be straight on both 
sides with no slant.  If it is not then click on this option to return to the RX clock numbers back 
before the change was made and try re-doing the slant correction. once you adjusted the image to 
where there is no slant. remember to click on the MEM button to record the new setting.

Accuracy of initial sync - When MMSSTV receives SSTV signals, it attempts to get its RX 
operation synchronized to the signals. Accuracy of initial sync specifies the number of scan lines 
used for locating the synchronization timing (point).

Normal: MMSSTV uses first four scan lines to locate the synchronization timing

Higher: MMSSTV uses first four scan lines to locate the
synchronization timing. It then uses 16 scan lines to locate the
synchronization timing again.
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Highest: MMSSTV firstly uses four scan lines to locate the
synchronization timing. It then uses 32 scan lines to locate the
synchronization timing again.

MMSSTV uses the least squares method for locating the synchronization
timing. Therefore, the more lines it used, the more precise timing it
could generate.

Auto stop - This option allows the program to stop receiving an image if the signal become lost or 
too weak to copy.

Auto restart - When the auto start in the RX window of the Setup MMSSTV is checked or here in 
the menu, MMSSTV restarts the receiving from the beginning in case it detects the VIS signal even 
during the receive operation. It should be noted, however, that MMSSTV would not be able to detect 
the VIS signal because of the RxBPF effect.

Auto resync - When the auto resync box in the RX window of MMSSTV Setup is checked or here 
in the menu, MMSSTV automatically attempts to re-synchronize the RX image. This is useful if the 
MMSSTV has lost the synchronization during RX. However, a couple of lines are displayed with the 
old synchronization timing and therefore they might appear as a thin bar.

Auto slant adjustment - In Automatic slant adjustment, MMSSTV periodically measures the 
interval of the synchronization signals and automatically adjust the slant. When you leave this mode 
turned on, MMSSTV adjust the image in real time, but it gives slightly less accuracy than the High-
accuracy slant adjustment.

Auto clear - Placing a check mark here will cause MMSSTV to clear the current image in the RX 
window at the start of the next incoming signal. leaving it unchecked will leave the current image on 
the RX window while receiving a new image. the new image will eventually cover up the old image.

Cancel - Closes the menu

Next
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Slant Corrections

Not all soundcards work the same (especially PCI soundcards) some have different frequencies for 
recording and playing. even if you have correctly adjusted the RX clock for receiving pictures in 
straight, you would still have a slanted image in the TX mode. MMSSTV 1.11 has several ways to 
adjust the soundcard clock frequencies for TX and RX independently.

- High-accuracy slant adjustment
- Automatic slant adjustment
- Manual slant adjustment

High-accuracy slant adjustment and Automatic slant adjustment analyze the timing of the received 
signal to automatically adjust the slant. They, however, might not work well in the situations of 
QRM, multipath, or weak signals.

Receive Slant Correction

There are several ways to correct the receive slant adjustment, So that you may start receiving them 
pretty pictures in straight.

Method 1.

                In normal situations, you would only have to adjust the slant by using the Sync window. If 
you want to calibrate your soundcard very accurately, listen to the standard radio or fax wave.

1) Go Option, MMSSTV Setup, Misc page, and push Adj button.
2) Receive standard radio wave (e.g., WWV and JJY).
3) Tune into the tick sound.
4) Continue listening to the sound for a while. You have a vertical line.
5) Click the upper point of the line.
6) Click the lower point of the line.
7) Notice in the Misc page you now have a new RX Clock number. click Ok to save it 

You could use FAX broadcasting instead of WWV or JJY, but be sure it has exact timing. Refer to 
the MMTTY help for details.

Method 2

                This method seems to be used by a lot of folks. Get a friend that has his/her sstv program 
all calibrated and have him/her send a picture. At the end of his/her transmission. you will notice that 
the image may have came in slanted to one side. In MMSSTV there are several ways to fix this. 

One way is to correct it manually using the slant button under the sync tab. click on the slant button, 
then left click at the top of the image where the slants starts. drag the mouse down the image 
following the slant, once at the bottom left click again. you will notice that the numbers have 
changed and the MEM button lit up click on the MEM button to record the new rx clock numbers 
into setup. have your friend send another picture to see if the program receives the image in straight. 
If not repeat the steps explain above until image finally comes in straight. 

Second way is a lot easier and requires less work. Have your friend send a picture to you. after 
receiving it. click on the sync tab. you will see a smiley face next to the x4 button. simply click it and 
MSSTV will automatically adjust the slant for you. The RX clock frequency numbers will change, 
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click on the MEM button to record the new numbers into the setup. In most cases you will only have 
to do this only once depending on band conditions. have your friend send another picture to double 
check the new setting. 

Failing to click on the MEM button to record the new RX clock frequency. will only apply the 
changes to the current received picture.

Auto Slant Adjust 

Although you have the sampling frequency accurately calibrated, the station you are in contact with 
might not have it done correctly. To facilitate the slant adjustment, MMSSTV has an automatic slant 
adjustment function.

To activate this function:
Check "Auto slant" in the RX window of Setup MMSSTV under options up top of the main window 
or Right click the RX image window and check Auto slant adjustment.

It should be noted, however, that this function will not always give a satisfactory result when you 
have multipath or QRM, which causes jitters in the synchronization.

* Note - The automatic slant adjustment can be used only if the receive buffer is turned on.

* If you have a very slanted image with the default sampling frequency, try changing the source of 
the soundcard to Stereo (Left or Right) in the Misc page of the Setup window. Some soundcards 
have different sampling frequencies in Monaural and Stereo settings.

Adjustment of TX offset

Assuming that you have the RX clock calibrated, MMSSTV transmits the signal and receives it 
through the external loop back.
After you have adjusted the slant (push the smiley button), push the TX button in the Sync window. 
MMSSTV automatically records the TX  offset frequency.
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TX Slant Correction

Adjustment of the slant of the TX image

Some soundcards (especially PCI form factors') have slightly different frequencies for recording and 
playing. In this particular case, even if you have correctly adjusted the clock in RX, you would have 
a slant image in TX.

MMSSTV has a means to adjust the soundcard clock for TX and RX independently. Refer to the 
Soundcard section at the end of this document for details.

Clock calibration

In SSTV, the discrimination of the clock appears as a slanted image. For MMSSTV, you are not 
required to have the absolute and exact clock frequency value (e.g. 11025Hz). But it is important to 
get MMSSTV informed on what the frequency of your soundcard has.

In normal situations, you would only have to adjust the slant by using the Sync window. If you want 
to calibrate your soundcard very accurately, listen to the standard radio or fax wave.

1) Go Option, MMSSTV Setup, Misc page, and push Adj button.
2) Receive standard radio wave (e.g., WWV and JJY).
3) Tune into the tick sound.
4) Continue listening to the sound for a while. You have a vertical line.
5) Click the upper point of the line.
6) Click the lower point of the line.

You could use FAX broadcasting instead of WWV or JJY, but be sure it has exact timing. Refer to 
the MMTTY help for details.

If your soundcard seems to have different clock sampling frequencies for TX and RX, adjust the 
offset frequency with the following procedure.

1) Adjust the slant in RX.
2) Go Option, MMSSTV Setup, and TX page. Select External in the Loopback.
3) Connect the Line-out to the Line-in of your soundcard.
4) Transmit an image with Martin 1.
5) You should have an image through the external feedback.
6) After completing the image receive, go Sync page and adjust the slant.
- You could use the High-accuracy slant adjustment.
- Do not push the Mem button
7) Push the TX(TX offset) button in the sync page.
8) Make sure that you have no slant in the TX. If you still have slant, repeat from (6).

It is a good idea to use the High-accuracy slant adjustment at Step 6. If you are not satisfied with the 
result, start it again. Never push the Mem button at this step.

You can use the LoopBack function of a mixer program instead of using the external feedback line.

Although this procedure can be applied only for the soundcard that supports the full-duplex mode, 
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the soundcard that does not support the full-duplex mode should not have different frequencies for 
TX and RX, and therefore you do not need this calibration.

If you have a report that your TX image is greatly slanted, try changing the soundcard modes, 
monaural or stereo (Source in the Misc window of Setup MMSSTV).

Some soundcards seem to use different sampling frequencies for the full-duplex and no-full-duplex 
operations.
In such a case, the offset calibration using the external loop back does not help. You should always 
have the loop back External or consult the QSO report.
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Scope Window

Tone frequency

SSTV's tone frequencies are defined as follows:
Synchronization pulse 1200 Hz
Low level of the image 1500 Hz
High level of the image 2300 Hz

There are four marker lines in the spectrum window of MMSSTV. From left to right:
Green line 1200Hz Synchronization pulse
Yellow line 1500Hz Low level of the image
Yellow dotted line 1900Hz Center level of the image
Yellow line 2300Hz High level of the image

To tune the frequency, make the signal energy be laid between the 1500Hz and 2300Hz marker lines. 
Alternatively, you can tune the receiver so that the synchronization pulses are on the 1200Hz marker 
line. However, the synchronization pulse is very short, so it might take time for you to get used to 
adjusting the frequency in this way. Since SSTV QSOs are made on the fixed common frequencies, 
you probably do not have difficulty in tuning the radio after you have done once. 

Notch filter

I have added an FIR notch filter in RX. To activate the notch filter, left click in the spectrum or 
waterfall window. The notch frequency is marked with a small triangle. To deactivate the notch 
filter, right click anywhere in the window. The notch filter eliminates the beat, but it slightly 
degrades the image quality. If the notch filter frequency is put closely to the synchronization signal, 
the RX operation sometimes stops for the weak signals if auto-stop function is turned on.
Sound ---> Notch ---> LMS -+-> BPF ---> Demodulator | --> Spectrum display

Level Indicator 

Left clicking inside the level indicator window will bring up the soundcard record control window 
settings.
If your not getting any audio showing in the level indicator and the spectral display. left  click the 
indicator and make
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sure the line in section has a check mark in the box.

Right clicking inside the level indicator window will bring up the soundcard play control window 
settings. 
When sending images and the radio keys up, but there is no audio being transmitted. right click the 
indicator
and turn up the play control (volume) slider. Do not turn it up too high. doing so will cause your 
audio signal to be overdriven.
Best way to adjust this is to turn the meter switch on the rig to ALC and then adjust the play control 
slider until the needle/level
reaches the half way mark on the meter. 
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MMSTV Misc Setup

Sound Card - These deal with the sound card being used for MMSSTV
        FIFO -  If MMSSTV has lost the timing during TX, it shows a caution message after the TX 
completion. In this particular case, you might be able to solve this problem by increasing the number 
of TX-FIFO. FIFO specifies the number of the buffer for the low-level sound processing. As the 
number is increased, the possibility of timing loss is decreased because of larger sound processing 
margin. Enlarge the RX-FIFO if you lose the timing in RX. Enlarge the TX-FIFO if you lose the 
timing in TX. This also kind of deals with CPU usage. The higher the number, less CPU power is 
used. lower the number then more CPU power is used.

Priority - Select the priority setting of the sound card you want MMSTV to have over other 
applications.

Device ID - If you have more than one sound card installed in your computer MMSSTV assigns an 
ID to each one. select the sound card you wish to use. When you have only one sound card, put -1 or 
0 to Device ID. -1 uses the default sound card. The sound card IDs are sequentially assigned as 0, 1, 
2, .... When you have two sound cards, for example, and want to use the second one for MMSSTV, 
set the Device ID to 1.

Source - Source defines the channel of the sound card. Mono makes the sound card work in the 
monaural mode. Left or Right makes the sound card work in the stereo mode and uses one of the 
channels. In TX, MMSSTV outputs the sound to both channels irrespective of the Source setting. 
When selecting left or right a TxCH option appear. check this box if you want the transmit audio to 
use the selected channel only.  Most sound cards today have 2 audio output slots, a left channel and a 
right channel. when plugging in your audio output cable from your keying circuit between the radio 
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and the computer and you get no transmit on the radio when sending a image. trying moving the plug 
to the next slot. if in the left, move it to the right and try again. if  the radio still does not transmit. 
check the software for the sound card. find the sound mixer and check to see if the 4 speaker option 
is selected.

Clock - This deals with RX/TX clock timings for slant corrections. Once you have MMSSTV 
sending and receiving images straight. write these numbers down. Put them in a safe place, in case 
you have to re-install MMSSTV for some reason. then you won't have to go through re-aligning 
everything.

Hz window - This is the RX clock frequency numbers. This deals with how straight you receive 
images.

Adj button - Clicking the button brings up a sound card calibration window with some 
instructions for setting up the clock frequencies with the time standard broadcast signals..
Tx offset window - This is the TX clock offset numbers. this deals with how straight you are 
sending your images.

Water Fall - This changes the colors of the waterfall. L = Background color and H = The waterfall. 
click on the colored squares to change their colors.

History Max - Default is 32. this allows you to store from 4 images up to 256 images in the history 
folder. once it has reached it's selected max, the first oldest image is automatically deleted and 
replaced with the newly received one

JPEG - Quality of saved Jpeg images is defined here.

Save window location - If not running MMSSTV in full screen, checking this option will save the 
MMSSTV window where it was last left on the screen.

Always use DIB - Device-Independent Bitmaps

A device-independent bitmap (DIB) contains a color table. A color table describes how pixel values 
correspond to RGB color values, which describe colors that are produced by emitting light. Thus, a 
DIB can achieve the proper color scheme on any device. A DIB contains the following color and 
dimension information:

* The color format of the device on which the rectangular image was created.
* The resolution of the device on which the rectangular image was created.
* The palette for the device on which the image was created.
* An array of bits that maps red, green, blue (RGB) triplets to pixels in the rectangular image.
* A data-compression identifier that indicates the data compression scheme (if any) used to reduce 
the size of the array of bits.

System Font - This option will allow you to change the system font MMSSTV uses and the size as 
well as the language. Change fonts, size, color using the "other" button.

FFT - The colored squares are for the spectrum window. you can change the colors of the lines and 
background by clicking on one of the squares.

Priority of MMSSTV - Priority defines the task priority for low level sound processing. If you lose 
the sound during RX or TX, raise the priority. You will get a message that shows up in the spectral 
display telling you if you lost sound. If the response of the menu operations is slow, lower the 
priority. Normal is the lowest and Critical is the highest priority. 
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AFC and LMS

AFC

AFC is activated by pushing the AFC button in the DSP pane on the main 
window. The default is ON. When AFC is locked to the signal, the triangle marker on the 
synchronization frequency line is displayed in blue. When AFC is unlocked, the triangle marker is 
displayed in red. While in red, the response to the frequency discrimination becomes slow.

* The AGC in the previous versions was deleted because it seemed to offer no improvements.

LMS filter selection

Three LMS filter modes can be selected by right clicking on the LMS button in the DSP pane of the 
main window.

- Noise smoothing: Conventional (default)
- Auto notch (fast): Automatic notch filter with fast response
- Auto notch (slow): Automatic notch filter with slow response

The response of the automatic notch filter is intentionally set slow so as not to degrade the image 
quality. Even set so, some images will be affected.

.
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Buff is the buffer size of the low level sound processing. You should enlarge the buffer size if you 
increase the sampling frequency; otherwise 
you may possibly lose the sound. Use 2048 or larger, buffer size for the sampling frequency of 
11025Hz. Use 4096 or larger, buffer size for
the sampling frequency of 22050Hz.

MMSSTV has a 12-second sound buffer, which should be big enough in the normal environment. If 
your PC is not powerful, you had better
not do other operations during transmission.

If MMSSTV has lost the timing during TX, it shows a caution message after the TX completion. In 
this particular case, you might be able to
solve this problem by increasing the number of buffers in the Misc page of the Setup window.
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===================================

Known problems when running programs from Shortcuts
---------------------------------------------------

Q- Why does MMSSTV creates a file on my desktop? (yourcallsign.MDT)

A - This happens when the path to MMSSTV is not properly set in the shortcut. 
** See below **

Q- When starting MMSSTV from your "Desktop" or "Quicklaunch" Shortcut, you get 
a box popping up that says "Log file (yourcallsign.MDT) does not exits, create it?" 
If this happens, "Answer NO." If you answer YES, your Log file may be put on your
desktop As in question 1. 

A- To avoid this happening or to fix this problem do the following: 

Right click on the "Desktop" and/or "Quicklaunch" icon, then click "Properties". 

Next Edit the shortcut: In the "Start in" box adding the correct path where you 
have installed MMSSTV. eg. "C:\Program Files\MMSSTV" if you installed MMSSTV 
in the default folder.

There is no way of fixing this in the install program. This is something that can
be added to the list as something that may be able to be fixed in the program.

=================================== 
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